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Installation Task Flows

Choose one of the following installation task flows:

Task Flow Description

Cluster Installs

Basic Installation Task Flow, on | Use this method for basic installs of any of the following deployments:

page 3 * Cisco Unified Communications Manager telephony cluster installs

+ Standard Deployments (Decentralized) for IM and Presence

Install IM and Presence Central For Centralized Deployments of IM and Presence, use this task flow for
Cluster (Basic Installation), on page | basic installs of the IM and Presence central cluster.
5

Touchless Installation Task Flow, | Use this task flow to install a Unified Communications Manager or IM
on page 19 and Presence Service cluster dynamically without the need for manual
intervention. Applies to either Centralized or Standard (Decentralized)
IM and Presence deployments.

Install with Data Import, on page | Complete this tasks to install a Unified Communications Manager or
25 IM and Presence Service cluster using the I nstall with Data Import.

Node Installs

Add a New Node to an Existing | Complete these tasks if you want to add a node to an existing Unified
Cluster, on page 23 Communications Manager or IM and Presence Service cluster.
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Note  You can also use Cisco Prime Collaboration Deployment to install your cluster. For motr information, see
Cisco Prime Collaboration Deployment Administration Guide.

Installation Task Flows

Choose one of the following installation task flows:

Task Flow Description

Cluster Installs

Basic Installation Task Flow, on | Use this method for basic installs of any of the following deployments:

page 3 * Cisco Unified Communications Manager telephony cluster installs

+ Standard Deployments (Decentralized) for IM and Presence

Install IM and Presence Central For Centralized Deployments of IM and Presence, use this task flow for
Cluster (Basic Installation), on page | basic installs of the IM and Presence central cluster.
5

Touchless Installation Task Flow, | Use this task flow to install a Unified Communications Manager or IM
on page 19 and Presence Service cluster dynamically without the need for manual
intervention. Applies to either Centralized or Standard (Decentralized)
IM and Presence deployments.

Install with Data Import, on page | Complete this tasks to install a Unified Communications Manager or
25 IM and Presence Service cluster using the I nstall with Data Import.

Node Installs

Add a New Node to an Existing | Complete these tasks if you want to add a node to an existing Unified
Cluster, on page 23 Communications Manager or IM and Presence Service cluster.

\}

Note  You can also use Cisco Prime Collaboration Deployment to install your cluster. For motr information, see
Cisco Prime Collaboration Deployment Administration Guide.

Before You Begin

Before you begin the installation, review the following information:

» Make sure that the subscriber nodes that you are installing can connect to the publisher node server during
the installation.

» Make sure that all Unified Communications Manager servers in a cluster have the same software version.
Make sure that all IM and Presence servers in a cluster have the same version of the released software.
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Installation Wizard .

The only exception is during a cluster software upgrade, during which a temporary mismatch is allowed.
If you are installing IM and Presence nodes,Unified Communications Manager and IM and Presence
Service software versions must have the same major and minor release number.

* If you are installing on an existing cluster, do not attempt to perform any configuration tasks during the
installation.

* Be aware that directory names and filenames that you enter while you are running the installation program
are case-sensitive.

* For IM and Presence Service installations, make sure that you know whether you are installing IM and
Presence Service in a Centralized Deployment or in a Standard Deployment (Decentralized). For details,
see Cluster Topology for IM and Presence.

Installation Wizard

The following table provides instructions on how to navigate within the installation wizard.

Table 1: Installation Wizard Navigation

To Do This Press This

Move to the next field Tab

Move to the previous field Alt-Tab

Choose an option Space bar or Enter

Scroll up or down in a list Up or down arrow

Go to the previous window Space bar or Enter to choose Back (when available)
Get help information on a window Space bar or Enter to choose Help (when available)

\}

Note The installation wizard supports the following characters:
* alphanumeric: A-Z, a-z, and 0-9- spaces
* spaces and # (except as the first character)

* only the following special characters: \.,-_:;{}()[]

all other characters are not supported.

Basic Installation Task Flow

Complete the following tasks to install Unified Communications Manager and IM and Presence Service cluster
using the basic installation process:

* Installs of a Cisco Unified Communications Manager telephony cluster
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* Installs of the IM and Presence Service in a Standard Deployment (Decentralized).

\)

Note

Depending on your installation scenario, you may not need to perform all of the tasks. For example, if you
are installing the IM and Presence Service on an existing Unified Communications Manager cluster that is

already in use, you only need to complete the tasks for installing the IM and Presence Service.

Before You Begin

Preinstall Tasks for Unified Communications Manager

Preinstall Tasks for the IM and Presence Service

Cisco Unified Communications
Manager

IM and Presence Service

Description

Step 1

Basic Installation, on page 6

Begin the install process for
Unified Communications
Manager.

Step 2

Enter Configuration
Information for Preinstalled
Servers, on page 8

Pre-installed servers only (e.g.,
Cisco Business Edition). Add
pre-configured information to
the installation. Otherwise, skip
this task.

Step 3

Optional. Complete either of
the following tasks:

* Upgrade Install Image
from Local Source, on
page 9

» Upgrade Install Image
from Remote Server, on
page 10

Upgrade your install image to
a newer version. This optional
task is available for Unified
Communications Manager
installs only.

Step 4

Configure Basic Installation,
on page 12

Continue with the Basic
Installation process by
configuring your installation.

Step 5

Configure the Unified
Communications Manager
Publisher, on page 14

Configure and install software
on the publisher node.

Step 6

Add Subscriber Nodes, on
page 17

Add subscriber nodes to the
publisher node.

Step 7

Install Subscriber Nodes, on
page 18

Install software on your Cisco
Unified Communications
Manager subscriber nodes.
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Install IM and Presence Central Cluster (Basic Installation) .

Cisco Unified Communications
Manager

IM and Presence Service

Description

Step 8

Basic Installation, on page 6

Begin the install process for the
IM and Presence Service.

Step 9

Enter Configuration
Information for Preinstalled
Servers, on page 8

Pre-installed servers only (e.g.,
Cisco Business Edition). Add
pre-configured information to
the installation. Otherwise, skip
this task.

Step 10

Configure Basic Installation,
on page 12

Continue Basic Install process
for IM and Presence by
configuring the installation.

Step 11

Configure the IM and Presence
Publisher, on page 16

Configure and complete the
installation for the IM and
Presence database publisher
node.

Step 12

Add Subscriber Nodes, on
page 17

On the Cisco Unified
Communications Manager
publisher node, add IM and
Presence subscribers.

Step 13

Install Subscriber Nodes, on
page 18

Install software on your IM and
Presence Service subscriber
nodes.

Install IM and Presence Central Cluster (Basic Installation)

Complete these tasks to install an IM and Presence Service Centralized Deployment using Basic Installation.

* Unified CM Publisher (non-telephony)—The IM and Presence central cluster requires a local Unified
Communications Manager publisher node within the central cluster for database and user provisioning.
This node does not handle telephony. There is no need to install subscriber nodes.

* IM and Presence Central Cluster

\ )

Note

For basic installation of IM and Presence Service in a Decentralized (Standard) deployment, follow the Basic

Installation Task Flow, on page 3 to install both the telephony and IM and Presence clusters.

Unified CM Publisher
(non-telephony)

IM and Presence Central
Cluster

Description

Step 1

Basic Installation, on page 6

Begin the install process for the
Unified CM publisher node.
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Unified CM Publisher
(non-telephony)

IM and Presence Central
Cluster

Description

Step 2

Configure Basic Installation, on
page 12

Configure the Basic
Installation.

Step 3

Configure the Unified
Communications Manager
Publisher, on page 14

Configure the Unified CM
publisher node.

Step 4

Basic Installation, on page 6

Begin the install process for the
IM and Presence central cluster.

Step 5

Configure Basic Installation, on
page 12

Continue with the Basic Install
process for IM and Presence by
continuing the installation.

Step 6

Configure the IM and Presence
Publisher, on page 16

Configure the IM and Presence
database publisher node.

Step 7

Add Subscriber Nodes, on page
17

On the Unified CM publisher,
add IM and Presence subsciber
nodes.

Step 8

Install Subscriber Nodes, on
page 18

Complete the installation on the
IM and Presence subsicribers.

Basic Installation

Use this procedure for Unified Communications Manager and IM and Presence Service installations to begin
the basic install process. You can use this procedure if you are installing a cluster or adding a node to an
existing cluster.

Procedure

Step 1

in a location where the virtual machine can access it.

Note

Step 2

If you are using a configuration file created by the Answer File Generator, ensure that virtual floppy image

If you have a Cisco Business Edition 6000/7000 appliance with the software pre-installed, you
do not need to install from a DVD or ISO file, unless you want to re-image the server with a later
product release. Go directly to the configure basic installation procedure to enter the configuration
information. For more information, see Installation Guide for Cisco Business Edition 6000 or
Installation Guide for Cisco Business Edition 7000.

Perform one of the following:

* If you are installing from a DVD drive a VMware ESXi server host, insert the installation DVD into the
tray and restart the virtual machine, so that it boots from the DVD.

* [f you are installing from a data store ISO file located on the local ESXi host or on a storage area network
(SAN), edit the CD or DVD drive on the virtual machine to select the data store ISO file. Select the
option to connect at power on, and restart the virtual machine. If you have configured the virtual machine
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to use the ISO at the same time that you created the virtual machine using the OVA file, skip this step
and complete the rest of the procedure.
After the server completes the boot sequence, the DVD Found window displays.
Step 3 Click Yesto perform the media check. Or click No to skip the media check.

The media check verifies the integrity of the DVD. If the DVD has passed the media check previously, choose
to skip the media check.

Step 4 If you click Yesto perform the media check, the M edia Check Result window displays.

a) Ifthe Media Check Result displays Pass, click OK to continue the installation.

b) If the media check fails, either download another copy from cisco.com or obtain another DVD directly
from Cisco.

Step 5 In the Product Deployment Selection window, specify which product you want to install:

* Unified Communications Manager—Choose the product and click OK.
* IM and Presence Service—Select OK.
* Cisco Unity Connection—Select the product and click OK.

Note The window displays the products that are supported and not supported by your hardware. If only
one product is supported, you do not choose which product to install.

Step 6 If the software is currently installed on the server, the Overwrite Hard Drive window opens and displays
the current software version on your hard drive, DVD or ISO file. Click Yesto continue with the installation
or No to cancel.

Caution If you choose to continue with the installation, all existing data on your hard drive gets overwritten
and destroyed.

The Platform I nstallation Wizard window displays.

Step 7 In the Platform I nstallation Wizard window, choose one of the following options:

* To continue with the basic installation process, choose Proceed and continue. Allows you to configure
basic installation process.

« To continue with I nstall with Data Import, choose Import and continue.

Allows you to configure Unified Communications Manager and Instant Messaging and Presence Service
installation with Data Import.

* If you have a preinstalled server (for example, a Cisco Business Edition server), configure the pre-installed
software. Click Skip and go to Enter Configuration Information for Preinstalled Servers, on page 8.

« If you want to install the software first and then configure it later, click Skip. The installation process
installs the software and then prompts you to configure it after the installation is complete. This method
may increase the total time for the installation.

Step 8 In the Apply Additional Release window, if you have a newer Unified Communications Manager version
than your install image, you can elect to upgrade the installation to the newer release. This option is not
available for the IM and Presence Service

* Yes—Choose this option to upgrade the Unified Communications Manager install image to a newer
Service Release. Go to one of the following procedures:

» Upgrade Install Image from Local Source, on page 9
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» Upgrade Install Image from Remote Server, on page 10

* No—Choose this option if you are installing the IM and Presence Service or if you are installing Unified
Communications Manager and you do not want to upgrade the install image.

Step 9 In the Basic I nstall window, click Continueto install the software or configure the pre-installed software.

What to do next
For pre-installed servers, Enter Configuration Information for Preinstalled Servers, on page 8.

To upgrade the Unified Communications Manager install image to a later release, peform any of the following
procedures:

» Upgrade Install Image from Local Source, on page 9

 Upgrade Install Image from Remote Server, on page 10

To continue the basic install process, Configure Basic Installation, on page 12

Enter Configuration Information for Preinstalled Servers

Use this procedure if you have a server with the product pre-installed (for example, a Cisco Business Edition
appliance). You can use a USB key or AFG file to enter your server's pre-configured information.

Before you begin

Basic Installation, on page 6

Procedure
Step 1 After the system restarts, the Preexisting I nstallation Configuration window displays.
Step 2 If you have preexisting configuration information that the Answer File Generator created, that is stored on a

USB key. Insert the USB key and choose Continue. The installation wizard reads the configuration information
during the installation process.

Note If a popup window states that the system detected new hardware, press any key and then choose
Install from the next window.

Step 3 In the Platform Installation Wizard window, choose Proceed.

Step 4 In the Apply Additional Release window, you can choose the option to upgrade Unified Communications
Manager install file to a newer release. This option is not available for the IM and Presence Service.

* Yes—Choose this option to upgrade the Unified Communications Manager install image to a newer
Service Release. Go to one of the following procedures:

> Upgrade Install Image from Local Source, on page 9
> Upgrade Install Image from Remote Server, on page 10

* No—Choose this option if you are installing the IM and Presence Service or installing Unified
Communications Manager and you do not want to upgrade the install image.
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Step 5 In the Basic I nstall window, choose Continue.

What to do next

To upgrade the Unified Communications Manager install image to a newer release, perform any of the following
procedures:

» Upgrade Install Image from Local Source, on page 9

* Upgrade Install Image from Remote Server, on page 10

Otherwise, to continue the basic install process, Configure Basic Installation, on page 12

Upgrade Install Image from Local Source

Use this optional procedure for Unified Communications Manager installations if you have a newer version
than your installation image and you want to upgrade your installation file to a newer version. This option is
available for Unified Communications Manager installs only.

)

Note If you have placed your upgrade file on an FTP or SFTP server, refer to Upgrade Install Image from Remote
Server, on page 10.

Before you begin

Make sure to do the following:

N

Note To complete this procedure, you must have completed the Start Basic Installation procedure and have chosen
to apply a patch via a LOCAL source.

» Start a basic installation. Choose the option to apply apatch via a LOCAL source. For details, see

» Download the appropriate patch file from Cisco.com. You must create an ISO image from the upgrade
file and then either place it on a DVD or in the DVD drive of a virtual machine.

Procedure

Step 1 When the L ocal Patch Configuration window displays, enter the patch directory and patch name, if required,
and choose OK.

The Install Upgrade Patch Selection Validation window displays.

Step 2 The window displays the patch file. To update the system with this patch, click Continue.

Step 3 Choose the upgrade patch to install. The system installs the patch, then restarts the system with the upgraded
software version running.

After the system restarts, the Preexisting Configuration Information window displays.
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Step 4 To continue the installation, choose Proceed .
The Platform Installation Wizard window displays.
Step 5 To continue the installation, click Proceed or click Cancel to stop the installation.
If you click Proceed, the Apply Patch window displays. Continue with the next step.

If you click Cancel, the system halts, and you can safely power down the server.

Step 6 When the Apply Patch window displays, choose No.
Step 7 The Upgrade window displays.
Step 8 Click No and perform the procedure to configure the basic installation.

What to do next

Configure Basic Installation, on page 12

Upgrade Install Image from Remote Server

Use this optional procedure for Unified Communications Manager installations if you have a newer version
than your installation image on an FTP or SFTP server and you want to upgrade your installation file to a
newer version. This option is available for Unified Communications Manager installs only.

)

Note If you have placed your upgrade file on an FTP or SFTP server, refer to Upgrade Install Image from Local
Source, on page 9.

Procedure

Step 1 Configure the auto negotiation setting.

* To enable automatic negotiation, choose Yes. This option sets the speed and duplex settings of the
Ethernet network interface card (NIC) by using automatic negotiation. The M TU Configuration window
displays. Skip the next step and then continue.

Note To use this option, your hub or the Ethernet switch must support automatic negotiation.

* To disable automatic negotiation, choose NO. The NIC Speed and Duplex Configuration window displays.
Continue with the next step.

Step 2 If you chose to disable automatic negotiation, manually choose the appropriate NIC speed and duplex settings
now and choose OK to continue.

The MTU Configuration window displays.

Step 3 In the MTU Configuration window, you can change the MTU size from the operating system default.

The maximum transmission unit (MTU) represents the largest packet, in bytes, that this host transmits on the
network. If you are unsure of the MTU setting for your network, use the default value.

Caution If you configure the MTU size incorrectly, your network performance can be affected.
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Upgrade Install Image from Remote Server .

* To accept the default value (1500 bytes), choose No.

* To change the MTU size from the operating system default, choose Yes, enter the new MTU size, and
choose OK.

The DHCP Configuration window displays.

For network configuration, you can choose to either set up static network IP addresses for the node and gateway
or to use Dynamic Host Configuration Protocol (DHCP). Static IP addresses are recommended. If you use
DHCP, use static DHCP.

* If you have a DHCP server that is configured in your network and want to use DHCP, choose Yes. The
installation process attempts to verify network connectivity.

* If you want to configure static IP addresses for the node, choose No. The Static Network Configuration
window displays.
If you chose not to use DHCP, enter your static network configuration values and choose OK.

The DNS Client Configuration window displays.

To enable DNS, choose Yes, enter your DNS client information, and choose OK.

After the system configures the network and checks for connectivity, the Remote Patch Configuration window
displays.

Enter the location and login information for the remote file server. The system connects to the remote server
and retrieves a list of available upgrade patches.

If the upgrade file is located on a Linux or Unix server, you must enter a forward slash at the beginning of
the directory path. For example, if the upgrade file is in the patches directory, you must enter /patches.

If the upgrade file is located on a Windows server, remember that you are connecting to an FTP or SFTP
server, so use the appropriate syntax, including:

* Begin the path with a forward slash (/) and use forward slashes throughout the path.

* The path must start from the FTP or SFTP root directory on the server, so you cannot enter a Windows
absolute path, which starts with a drive letter (for example, C:).

The Install Upgrade Patch Selection window displays.

Choose the upgrade patch to install. The system downloads, unpacks, and installs the patch and then restarts
the system with the upgraded software version running.

After the system restarts, the Preexisting Configuration Information window displays.

To continue the installation, choose Proceed.

The Platform Installation Wizard window displays.

Choose Proceed or choose Cancel to stop the installation.
If you choose Proceed, the Apply Patch window displays. Continue with the next step.

If you choose Cancel, the system halts, and you can safely power down the server.

In the Apply Patch window displays, choose No.
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. Configure Basic Installation

Step 12

The Windows Upgrade window displays.

Choose No and perform the Configure Attended Installation procedure to configure the basic installation.

What to do next

Configure Basic Installation, on page 12

Configure Basic Installation

Step 1

Step 2

Step 3

Step 4

Use this procedure to configure Unified Communications Manager and IM and Presence Service basic
installation.

Before you begin

Basic Installation, on page 6

Procedure

In the Timezone Configuration window, choose the appropriate time zone for the server and then choose
OK.

The Auto Negotiation Configuration window is displayed.

The installation process allows you to automatically set the speed and duplex settings of the Ethernet network
interface card (NIC) by using automatic negotiation. You can change this setting after installation.

* To enable automatic negotiation, choose Yes.
The MTU Configuration window is displayed.

Note To use this option, your hub or Ethernet switch must support automatic negotiation.

* To disable automatic negotiation, choose N0 and continue with the next step.

The NIC Speed and Duplex Configuration window is displayed.

If you chose to disable automatic negotiation, manually choose the appropriate NIC speed and duplex settings
now and choose OK to continue.

The MTU Configuration window displays.

In the MTU Configuration window, you can change the MTU size from the operating system default.

The maximum transmission unit (MTU) represents the largest packet, in bytes, that this host will transmit on
the network. If you are unsure of the MTU setting for your network, use the default value, which is 1500
bytes.

Caution If you configure the MTU size incorrectly, your network performance can be affected.

* To accept the default value (1500 bytes), choose No.
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* To change the MTU size from the operating system default, choose Yes, enter the new MTU size, and
choose OK.

The DHCP Configuration window displays.

Step 5 For network configuration, you can choose to either set up a static network IP address for the node or to use
Dynamic Host Configuration Protocol (DHCP). Static IP addresses are recommended. If you use DHCP, use
static DHCP.

* If you have a DHCP server that is configured in your network and want to use DHCP, choose Yes. The
network restarts, and the Administrator Login Configuration window is displayed.

* If you want to configure a static IP address for the node, choose No. The Static Network Configuration

window displays.

Step 6 If you chose not to use DHCP, enter your static network configuration values and choose OK.

The DNS Client Configuration window is displayed.

Step 7 In the DNS Client Configuration window, click Yesto enable DNS and enter the DNS client information.
Step 8 Click OK and choose one of the following in the Basic Installation procedure:
* Proceed:

* Click Proceed to restart the network using the new configuration. The Administrator Login
Configuration window is displayed.

* Enter Administrator login User Name and Password
Note Make sure that the User Name contians alphanumeric characters. Use the same login
cerdentials to Cisco Unified Communications Operating System Administration, the
Command Line Interface, and the Disaster Recovery System.
» Software L ocation of Data to Import

* Enter Remote Server Name or IP, Export Data Directory, Remote Login ID, Remote Password, and
Confirm Password. Click OK to restart the network using the new configuration.

Step 9 The Certificate | nformation window is displayed.
Step 10 In Certificate I nformation window, enter your certificate signing request information and click OK.
Step 11 In the First Node Configuration window, choose how you want to assign this node:

*» Yes—Choose this option to assign this node as the Cisco Unified Communications Manager publisher
node.

* No—Choose this option to assign this node as a Cisco Unified Communications Manager subscriber
node, or as an IM and Presence Service node.

What to do next

If you are installing the first node in the cluster, go to one of the following procedures, depending on whether
you are installing Unified Communications Manager or the IM and Presence Service.:
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* Configure the Unified Communications Manager Publisher, on page 14

* Configure the IM and Presence Publisher, on page 16

Otherwise, for subscriber node installs Add Subscriber Nodes, on page 17.

Configure the Unified Communications Manager Publisher

Follow this procedure to configure the first server where you install Unified Communications Manager software
as the publisher node for the cluster. Perform this procedure after you have completed the attended installation
and configured the attended installation.

\)

Note  You can configure Smart Call Home on the publisher node only.

Procedure

Step 1 The Network Time Protocol Client Configuration window appears.

We recommend that you use an external NTP server to ensure accurate system time on the publisher node.
Subscriber nodes in the cluster will get their time from the first node.

Step 2 Choose whether you want to configure an external NTP server or manually configure the system time.

* To set up an external NTP server, choose Yes and enter the IP address, NTP server name, or NTP server
pool name for at least one NTP server. You can configure up to five NTP servers, and we recommend
that you use at least three. Choose Proceed to continue with the installation.

The system contacts an NTP server and automatically sets the time on the hardware clock.
Note If the Test button appears, you can choose Test to check whether the NTP servers are

accessible.

* To manually configure the system time, choose No and enter the appropriate date and time to set the
hardware clock. Choose OK to continue with the installation.

The Database Access Security Configuration window appears.

Step 3 Enter the Security password from Required Installation Information.

Note The Security password must start with an alphanumeric character, be at least six characters long,
and can contain alphanumeric characters, hyphens, and underscores. The system uses this password
to authorize communications between nodes, and you must ensure this password is identical on
all nodes in the cluster.

The SMTP Host Configuration window appears.

Step 4 If you want to configure an SMTP server, choose Yes and enter the SMTP server name. If you do not want
to configure the SMTP server, choose NO, which redirects to Smart Call Home page. To go to previous page,
choose Back and to see the information about the SMTP configuration, choose Help.
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Note You must configure an SMTP server to use certain platform features; however, you can also
configure an SMTP server later by using the platform GUI or the command line interface.

Step 5 Choose OK.
Step 6 In the SMART Call Home Enable window, choose one of the following and click OK:

« Enable Smart Call Home on System Start
» Enable Anonymous Call Home on System Start

* Remind me L ater to configure Smart Call Home—Select this option to configure the Smart Call
Home feature service after installation using the Cisco Unified Serviceability interface.
« Disable All Call Home on System Start—Select this option to deactivate the Smart Call Home feature

service. Please note that you can reactivate it after installation using the Cisco Unified Serviceability
interface.

Step 7 If you have selected Smart Call Home on System Start, do the following:

a) Select the method for sending data to the Cisco Technical Assistance Center.

* Secure Web (HTTPS)

* Secure Web (HTTPS) through Proxy—If you select this option, enter the Hostname or IP address
of the proxy server where the Call Home info gets sent as well as the port number on which the server
is enabled.

* Email—If you select this option, you must have configured SMTP for any emails to be sent
successfully.

b) To send a copy of the Call Home messages to multiple email recipients, enter the email addresses separated
with a comma. You can enter up to a maximum of 1024 characters.

¢) Inthe Customer Contact Details field, enter the customer's email address.
d) Click Continueto proceed, or select Back to return to the previous menu.

If you click Continue, a message appears as Cisco Call Home includes reporting
capabilities that allow Cisco to receive diagnostic and system
information from your Unified Communications Manager cluster. Cisco
may use this information for proactive debugging, product development
or marketing purposes. To learn more about this feature, please visit:
http://www.cisco.com/en/US/products/ps7334/serv_home.html.

Note If you have selected Secure Web (HTTPS) through Proxy and click Continue, the Smart
Call Home Proxy Configuration window appears.

e) Click Confirm to proceed with normal installation or select Back to return to the Smart Call Home Enable
Page.

Step 8 If you have selected Enable Anonymous Call Home on System Start, do the following:
a) Select the method for sending data to the Cisco Technical Assistance Center.

* Secure Web (HTTPS)

* Secure Web (HTTPS) through Proxy—If you select this option, enter the Hostname or IP address
of the proxy server where the Call Home info gets sent as well as the port number on which the server
is enabled.
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Step 9
Step 10
Step 11

Step 12

* Email—If you select this option, you must have configured SMTP for any emails to be sent
successfully.

b) To send a copy of the Call Home messages to multiple email recipients, enter the email addresses separated
with a comma. You can enter up to a maximum of 1024 characters.

¢) Click Continueto proceed, or click Back to return to the previous menu.
When you click Continue, the following message appears.

To help improve the Unified Communications Manager experience, click
Confirm to allow Cisco Systems to securely receive usage statistics
from the server. This information will be used by Cisco to help
understand how customers are using our product and ultimately drive
product direction. If you prefer not to participate, you may choose to
opt-out.

Note If you have selected Secure Web (HTTPS) through Proxy and clicked Continue, the
Anonymous Call Home Proxy Configuration window appears.

d) Click Confirm to proceed with normal installation or click Back to return to the Smart Call Home Enable
Page.

Note If you choose I nstall with Data I mport during basic installation the Application User
Configuration window does not appear. Proceed to step 11 to complete the installation.

Click OK. The Application User Configuration window appears.
Enter the Application User name and password from and confirm the password by entering it again.

Choose OK.
The Platform Configuration Confirmation window appears.

Choose OK to continue with the installation or choose Back to modify the platform configuration.
The system installs and configures the software. The server reboots.

When the installation process completes, you are prompted to log in by using the Administrator account and
password.

What to do next

If you want to install subscriber nodes, Add Subscriber Nodes, on page 17.

Configure the IM and Presence Publisher

Step 1
Step 2

Follow this procedure to configure the first server where you install IM and Presence Service software as the
database publisher node for the IM and Presence cluster.

Procedure

Install and configure the IM and Presence database publisher node.

Verify that the following services are running:
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Add Subscriber Nodes .

* Cisco SIP Proxy

* Cisco Presence Engine

* Cisco XCP Connection Manager

* Cisco XCP Authentication Service

If you need to activate services, you can do it in Cisco Unified Serviceability at Tools> Service Activation.

What to do next
Add Subscriber Nodes, on page 17

Add Subscriber Nodes

Before you install software on your subscriber nodes, you must add the subscriber nodes to the Unified
Communications Manager publisher node. You must complete this task before installing subscriber nodes
for either Unified Communications Manager or the IM and Presence Service.

Step 1
Step 2
Step 3

Step 4

Procedure

Log in to the Unified Communications Manager publisher node.
From Cisco Unified CM Administration choose System > Server.

Add your subscriber nodes:

a)
b)

¢)
d)

e)
f)

Click Add New.

From the Server Type drop-down list, choose the node type that corresponds to the install that you are
completing: Unified Communications Manager Voice/Video node, or IM and Presence node.

Enter the Fully Qualified Domain Name/I P Address field with a FQDN or IPv4 Address.

Note Do not use single quotes (' ') in the Description field while adding the node details.

Optional. If you are deploying IPv6, enter an | Pv6 Address.
Click Save.
Repeat these steps for each subscriber node that you want to add.

(IM and Presence Service only) Add your Presence Redundancy Groups in order to define your subclusters.

a)
b)
c)
d)
e)
f)

From Cisco Unified CM Administration, choose System > Presence Redundancy Groups.

Click Add New.

Enter a Name and Description for the group.

From the Server drop-down list, choose the IM and Presence nodes that you want to add to this group.
Click Save.

Repeat this procedure until you've created your groups. You can have up to three Presence Redundancy
Groups in a cluster, with each group consisting of two IM and Presence nodes.

What to do next

Install Subscriber Nodes, on page 18
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. Install Subscriber Nodes

Install Subscriber Nodes

Step 1

Step 2

Step 3

Step 4

Step 5

Use this procedure if you want to install subscriber nodes for Unified Communications Manager or the IM
and Presence Service.

Before you begin

Before you install software for either Unified Communications Manager or IM and Presence Service subscriber
nodes, you must add the node to the Cisco Unified Communications Manager publisher node. For details,
Add Subscriber Nodes, on page 17

Procedure

If you have configured Network Time Protocol on the publisher node, ensure that it is synchronized with an
NTP server before you install a subscriber node. From the Command Line Interface on the publisher node,
enter utils ntp status. Ensure that the output indicates that the node is synchronized with an NTP
server.

Note If the publisher node is not synchronized with an NTP server, installation of the subscriber node
will fail.

On the First Node Configuration window, read the Warning and make sure that you have correctly configured
the first node as the publisher node. To continue with the installation of the subscriber node, click OK.

The Network Connectivity Test Configuration window displays.

During installation of a subscriber node, the system checks to ensure that the subscriber node can connect to
the publisher node.

» To pause the installation after the system successfully verifies network connectivity, choose Yes.

* To continue the installation with a pause, choose NO.

The First Node Access Configuration window displays.

Enter the publisher node connectivity information and choose OK.
The system checks for network connectivity.

If you chose to pause the system after the system successfully verifies network connectivity, the Successful
Connection to First Node window displays. Choose Continue.

Note If the network connectivity test fails, the system always stops and allows you to go back and

reenter the parameter information.

The SMTP Host Configuration window displays.

If you want to configure an SMTP server, choose Yes and enter the SMTP server name.

Note To use certain operating system features, you must configure an SMTP server; however, you can
also configure an SMTP server later by using the operating system GUI or the command line
interface.

The Platform Configuration Confirmation window displays.
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Step 6
Step 7

Touchless Installation Task Flow .

Choose OK to start installing the software or choose Back to change the configuration.

When the installation process completes, you get prompted to log in by using the Administrator account and
password.

What to do next

If you have just installed a Unified Communications Manager cluster and you want to install the IM and
Presence Service on the same cluster in a standard IM and Presence deployment (as opposed to a central IM
and Presence cluster deployment), return to Basic Installation, on page 6 in order to install the IM and
Presence Service cluster.

Otherwise, proceed to the postinstallation tasks:

* Postinstall Tasks for Cisco Unified Communications Manager

* Postinstall tasks for the IM and Presence Service

Touchless Installation Task Flow

Complete these tasks to install your Unified Communications Manager and IM and Presence Service node or
clusters in a single process via the touchless installation method.

Before you begin
Preinstall Tasks for Unified Communications Manager

Preinstall Tasks for the IM and Presence Service

Procedure
Command or Action Purpose

Step 1 Generate Answer Files for Touchless Install, | Use this procedure to generate the configuration
on page 20 files (clusterconfig.xml and platformconfig.xml)

with your network settings. The touchless install
process uses these files to install and configure
a single node or the various cluster nodes.

Step 2 Generate Virtual Floppy Images, on page 21 | Use this procedure to create virtual floppy
images from the answer files. You use the
virtual floppy images in your touchless
installation.

Step 3 Upload Virtual Floppy Image to Datastore, on | Use this procedure to upload the virtual floppy

page 21 images to the datastore.
Step 4 Mount Floppy Image to VM, on page 22 Use this procedure to mount the UC application
virtual floppy images on their corresponding
VM.
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. Generate Answer Files for Touchless Install

Command or Action Purpose
Step 5 Run Touchless Install, on page 22 Begin the single node or cluster installation.
You can kick off all node installations
simultaneously.

Generate Answer Files for Touchless Install

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Use this procedure to generate answer files for your touchless installation of your cluster. The answer files
(clusterconfig.xml and platformconfig.xml) contain the configuration information that the install process
installs and configures on each cluster node.

Before you begin

You must have already planned your network topology, including addresses for your Unified Communications
Manager and IM and Presence Service cluster nodes.

Procedure

Log in to the Cisco Unified Communications Answer File Generator application at https://www.cisco.com/c/
en/us/applicat/content/cuc-afg/index.html.

In the Hardwar e section, choose Virtual Machine.
From the Product section, select the product and version that you want to install.

In the Software L ocation of Data to Import section, check the Configure Software L ocation of Data to
Import check box to configure Remote SFTP server details only if you choose to install using the Fresh Install
with Data Import. Else ignore this step and proceed to step 5. For more details, see Install with Data Import,
on page 25.

By checking the Configure Software L ocation of Data to Import check box it disables, Administrator
Credentials, Security Password, Application User Credentials fields. These details are imported from source
node data during installation. Enter the following fields:

* Remote Server Name or | P—The Secure FTP (SFTP) server that stores the source cluster's exported
data.

 Export Data Directory—Directory path of the server containing export data.
» Remote Server Login |D—Allows data retrieval of the remote SFTP server.

» Remote Server Passwor d—Can contain alphanumeric characters, hyphens, and underscores.

Complete the remaining fields under Clusterwide Configuration with your cluster configuration details.
Complete the fields in the Primary Node Configuration with configuration details for the publisher node.
Check the Dynamic Cluster Config Enable check box and enter a value, in hours, for the Dynamic cluster
Config Timer.

Note This check box must be checked if you want to install your full cluster in a single process.
Otherwise, you will need to either configure this option later through the CLI, or add your
subscriber nodes manually after the publisher node installs.
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Step 8

Step 9

Step 10
Step 11
Step 12

Generate Virtual Floppy Images .

Under Secondary Node Configuration, enter the node details for your first subscriber node and click Add
Secondary Node.

Add all your subscriber nodes.
Add all your cluster nodes and click Generate Answer files.
Download the answer files to your computer.

Repeat this procedure to generate answer files for the IM and Presence Service cluster.

What to do next

Generate Virtual Floppy Images, on page 21

Generate Virtual Floppy Images

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Use this procedure to create virtual floppy images from the answer files. You will use the virtual floppy images
in your touchless installation.

)

Note This procedure describes how to use Winimage to create virtual floppy images. You can download Winimage

from http: www.winimage.com download.htm. You can also use other tools, such as BFI, to create virtual
floppy images.

Procedure

From Winimage, choose File > New.

From the Standard format, choose 1.44 MB and click OK.

Navigate to the Menu Image, choose I nject and select the platformConfig.xml file.
When prompted to inject the file into Winimage, click Yes.

Choose File> Save As.

Save the file as a virtual floppy image (.flp file) using the following naming conventions:

* Unified Communications Manager—ucm. f1p
* IM and Presence Service—imp. flp

Repeat these steps for both the Unified Communications Manager cluster and the IM and Presence Service
cluster.

What to do next

Upload Virtual Floppy Image to Datastore, on page 21

Upload Virtual Floppy Image to Datastore

Use this procedure to upload the virtual floppy images to the datastore.
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. Mount Floppy Image to VM

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Procedure

Start the vSphere client.

Select the Configuration tab.

Select Storage.

Right-click on a datastore and Browse the datastore.

Navigate to the destination directory and click the Upload filesto this datastoreicon.
Upload the vFloppy images to your local folder.

At the Upload/Download warning, click Yes.

Close the Datastore Browser window.

What to do next

Mount Floppy Image to VM, on page 22

Mount Floppy Image to VM

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Use this procedure to mount the UC application virtual floppy images on their corresponding VM.

Procedure

In the vSphere client, choose the virtual machine.

Open VMware Remote Console (VMRC), and click the Floppy drive.

Select Use existing floppy imagein datastore.

Browse to the datastore and locate the virtual floppy image.

Select the file and click OK.

Under Device Status, enable the Connected and Connect at power on option.

Click the Optionstab. Under Boot Options, check Forceentry to BIOS and click OK.

Repeat this procedure for each VM on which you want to install a node.

What to do next

Run Touchless Install, on page 22

Run Touchless Install

After you have mounted your virtual floppy drives to your application VMs, run the touchless installation
process. You can install all nodes simultaneously.
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Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Add a New Node to an Existing Cluster .

Procedure

In vSphere client, right-click the VM and select Open Console. A console window opens.
Click the Power On icon in the console tool bar to power on the virtual machine.

When the BIOS screen appears, configure the following boot order:

a) CD-Rom

b) Hard Drive

¢) Removable Devices

d) Network

Save the settings and exit from the console. The installation commences immediately.

Repeat these steps for each cluster node. All cluster nodes may install in parallel; you do not have to install
them serially.

After to emphasise the completion of an activity, remove the vFloppy configurations from the virtual machines.

What to do next
Postinstall Tasks for Cisco Unified Communications Manager

Postinstall tasks for the IM and Presence Service

Add a New Node to an Existing Cluster

To add a new Unified Communications Manager or IM and Presence Service subscriber node to an existing
cluster, you can use either the Basic Installation or Touchless Installation methods to add and install the node.
Any new nodes that you add must be configured as subscriber nodes.

Basic Installation

For basic installations of additional Unified Communications Manager or IM and Presence Service cluster
nodes, complete the following tasks:

Procedure Description

Step 1 Run a full backup of the cluster. For details, see the "Manage Backups" chapter
of the Administration Guide for Cisco Unified
Communications Manager.

Step 2 Basic Installation, on page 6 Begin the install process.

Step 3 Configure Basic Installation, on page 12 Continue with the Basic Installation process
by configuring your installation.

Step 4 Add Subscriber Nodes, on page 17 Add subscriber nodes to Unified
Communications Manager publisher.

Step 5 Install Subscriber Nodes, on page 18 Install software on your subscriber nodes.
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For Touchless installations of additional Unified Communications Manager or IM and Presence Service cluster
nodes, complete these tasks:

Procedure

Description

Step 1

Run a full backup of the cluster.

For details, see the "Manage Backups" chapter
of the Administration Guide for Cisco Unified
Communications Manager.

Step 2

Generate Answer Files for Touchless Install,
on page 20

Generate answer files for your installation.
The touchless install process uses answer files
to install and configure the various cluster
nodes.

Step 3

Generate Virtual Floppy Images, on page 21

Create a virtual floppy image from the answer
file.

Step 4

Upload Virtual Floppy Image to Datastore,
on page 21

Upload the virtual floppy to the datastore.

Step 5

Mount Floppy Image to VM, on page 22

Mount the virtual floppy to the virtual
machine.

Step 6

Run Touchless Install, on page 22

Install the software.

Notes for Basic and Touchless Installs

| o

Important

After you install a new node on an existing cluster, if you plan to utilize Cisco CallManager or Cisco TFTP
services, we recommend that you restart all of the phones in your cluster to get the latest ITL file. If you are
using a Certificate Trust List (CTL), you will also need to update this file manually by running the utils ctl
update CTLFile CLI command (using Tokenless CTL) or by updating the file via the CTL Client (Legacy

USB tokens). After you update the CTL file, you must restart phones so that they can download the latest

CTL file. For additional details on the CTL File, see the “Cisco CTL Client Setup” chapter of the Security

Guide for Cisco Unified Communications Manager.

. Installation Tasks



| Installation Tasks

\)

Install with Data Import .

Note

* You can collect the logs from RTMT of a new node added to the existing FQDN cluster, only when you
restart the trace collection service. When you sign in to Unified RTMT without restarting the trace
collection, the following error message is displayed: .

Could not connect to 'Server' <new node name>

* [f you install a new node to an existing cluster where the IM and Presence server is not upgraded to the
supported version or if the IM and Presence server has been decommissioned, the following error message
is displayed:

"Add failed. Upgrade and migration for Cisco Unified IM & Presence
Servers that are associated with this cluster appears to be pending
(not complete). Please make sure upgrade and migration of all IM &
Presence servers is completed successfully before adding servers to
this cluster. Please check for any unused IM & Presence Application
Servers and delete them”.

Note

A touchless install cannot be used to simultaneously install multiple Unified Communications Manager and
multiple IM and Presence Service nodes. The following scenarios are supported:

* Installing only multiple Unified Communications Manager nodes

* Installing only one Unified Communications Manager node (publisher) and multiple and IM and Presence
Service nodes

If you need to simultaneously install multiple Unified Communications Manager and IM and Presence Service
nodes, you need to use one of the above scenarios and install additional nodes manually.

Install with Data Import

Use one of these steps to configure Unified Communications Manager and IM and Presence Service installation
with data import from an older version of Unified CM.

Step 1

Before you begin

Run the utils system upgrade dataexport initiate CLI command on each node of the desired source system
to export the data which can be imported using this procedure. Your source version must be Release 10.5 or
higher. If your source version is not Release 12.5(1) SUS5 or higher, you need to install the latest version of
the "ciscocm.DataExport" COP file on each node of the source system.

Procedure

To configure Unified Communications Manager and IM and Presence Service with | nstall with Data I mport
follow the instructions as described in Basic Installation, on page 6 from step 1 through 6. Then proceed
with the following steps:
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. Install with Data Import

a) In the Platform Installation Wizard window, click Import to import data from the SFTP server during
the Unified Communications Manager and IM and Presence Service installation. The installation process
starts with preinstallation and nodes are rebooted.

b) After reboot, click OK in Import Upgrade Configuration Information screen.

To continue the basic install process, see Configure Basic Installation, on page 12.

Step 2 To configure Unified Communications Manager and IM and Presence Service with Install with Data | mport
follow the instructions as described in Touchless Installation Task Flow, on page 19 from step 1 through 5.
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